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1 OVERVIEW
A VuMark is a new kind of Vuforia target that can be customized to closely reflect a
company’s brand identity.
It can both store encoded data as well as initialize an AR experience. One example of
VuMark usage is for enterprises: by affixing VuMarks to their manufactured equipment,
enterprises can both identify the piece of equipment and overlay augmentation that
indicates how to use it.
This document will help you create your own VuMark design. It provides guidelines to
help you design a VuMark that conforms to the requirements for making a functional
VuMark that will perform well.

Figure 1 - Example VuMarks

2 THE PARTS OF A VUMARK
VuMarks have five major parts that you will need to understand when designing your
own.
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CONTOUR
BORDER
CLEAR SPACE

CODE / ELEMENTS

BACKGROUND / DESIGN AREA

Figure 2 - VuMark Parts

2.1 Contour
The Contour is what the Vuforia computer vision algorithm first detects. After finding
the contour, the algorithm looks for the code and “reads” it to identify the value or “ID”
that is encoded within the VuMark.
The Contour is not explicitly drawn or visible in a VuMark design. Rather, the Contour
is the line that appears where two other parts of the VuMark meet – the Border and the
Clear Space. Essentially the Contour is defined by the contrast between the two
different colors of the Border and Clear Space.

2.2 Border
The Border is typically the most identifiable and defining shape within the VuMark. In
FIGURE 2, the Border is the outermost shape made of six straight lines forming a
hexagon.

2.3 Clear Space
The Clear Space is the mandatory blank area that appears adjacent to the border along
its entire length. The Clear Space can be either inside or outside of the border and is
required in order to guarantee there is enough contrast for the algorithm to detect the
Contour.
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2.4 Code / Elements
Every individual VuMark contains a unique Code, which is a visual representation of the
ID encoded in the VuMark.
The Code consists of Elements and the type of data and length of the value/ID that is
encoded determine the number of Elements. The larger the value length, the larger
number of elements that are required.
Every Element has 2 states: a “Dark” and “Bright” state. A unique code is generated by
setting some of the elements in the Dark vs. Bright state (roughly 50% of Elements in
each state).

2.5 Background / Design Area
The Background or Design Area is a layer where you can put any parts of the VuMark
that are not used for detection. There is a lot of freedom in designing and placing the
Background. We recommend to add graphically rich background if you plan to use
VuMark for tracking as well.
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3 DESIGN REQUIREMENTS
This section will help you design a VuMark that performs well in a variety of conditions.
To do that you’ll need to take into account the following considerations and
requirements.

3.1 Contour
The Contour is a part of the VuMark that is implied by the line created when placing the
Border and the Clear Space next to each other.
•
•
•

The Contour must consist of straight
lines that form a closed path.
The Contour must have at least 4
sides, and a maximum of 20 sides.
The Contour shall ideally not be
rotational symmetric (as shown in
lower row). If you decide to do,
additional steps are necessary during
design.

Yes

No
ILLUSTRATOR TIP: Create the Contour directly on the “VuMark-Contour” layer using
Illustrator’s “Pen Tool”, by manually rendering the underlying contrast border between
the Border and the Clear Space anchor-by-anchor.
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•

•

The length of smallest side of the Contour
must be at least 10% of the length of the
largest dimension of the overall VuMark.
o The largest dimension is the larger
of either the height or width.
o The overall size of a VuMark will
comprise all parts of the VuMark,
including the Background.

Largest
Dimension

Maximum angle limit between contour
segments is 150°. If you have designs where
the angle is bigger, the VuMark may not work.
Make sure to create less flat corners. Example
(‘No’ example has top and bottom corner with
very flat angles):

Yes

No

3.2 Border & Clear Space
The Border and Clear Space share the same design requirements. These requirements
guarantee that the Contour becomes a good quality contrast edge.
•

The width of the Border & Clear Space
must be at least 5% of the length of the
largest dimension of the overall VuMark.

Yes

No
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•

•

The Border and Clear Space must be filled
with a solid/uniform color; they can’t be
transparent or set to ‘No fill, and can’t
have a gradient or pattern fill.
Make sure these elements don’t use
Appearance Attributes.

Yes

No
•

There must be high contrast between the colors of the Border & Clear.
To ensure that there is enough contrast between the colors used for the Border and Clear Space,
you should convert those colors to grayscale, and then inspect the “K” value of each color. There
should be a “K” value difference of at least 30-40%, but more is better.
ILLUSTRATOR TIP: To find out the “K” value: Select an object, then from the Illustrator menu
choose: Edit ! Edit Colors ! Convert to Grayscale. Then using the Color panel, check the “K”
value (your color space must be set to CMYK).

•

The Clear Space can be placed either inside or outside of the Border, so that the Contour is
formed inside or outside of the Border.
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3.2.1 Advanced Techniques
Only the edge of the Clear Space that faces the Border must consist of straight lines and meet the
length requirements described above.
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3.3 Code / Elements
Determining the number of elements that your VuMark design must accommodate is
an important detail to figure out up front. Your choice of what type of data and the
length of that data or “ID” will determine how many elements will be needed in your
VuMark.
There are 3 types of data that can be encoded:
String
– Use this if an ID will consist of printable ASCII characters1.
Numeric
– Use this if an ID will only use numeric digits 0 - 9.
Byte
– Use this for data in byte format.
The section ‘Using the Setup script’ later in this document explains how to calculate
the number of elements that your design must have based on your data type and ID
length. Following design requirements apply to the Elements:
•
•

•

Every Element must have a Bright and Dark state defined.
An Element’s Bright and Dark state are represented by different colors that have high contrast to
each other. Ideally all Bright Elements have the same color, slight variation is acceptable. Same
applies for Dark Elements.
When placing the elements brighter elements must go on the “VuMark-BrightElements” layer.
ILLUSTRATOR TIP: To ensure that there is enough contrast between the colors used for the Dark
and Bright states, you should convert those colors to grayscale, and then inspect the “K” value of
each color. There should be a “K” value difference of at least 30-40%, but more is better.

•

The Bright and Dark states of any element must be in the exact same position (perfectly
overlapping).

•

An Element’s size (both the height and width) must be at least 3% of the length of the largest
dimension of the overall VuMark.

•

Each Element can be a unique size and shape provided the element meets the size requirement. Use
filled paths or compound paths only. Strokes only will not work. Also don’t use grouped or layered
items as Elements. Don’t use Appearance Attributes.

•

Elements don’t need to be adjacent – they can be scattered anywhere within the VuMark.

•

Elements can overlap with the Background/Design Area. They cannot overlap the Border, Clear

1

Printable ASCII characters: https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
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Space or other Elements.
•

Elements can be placed inside or outside of the Border and Clear Space but the farthest Element
must be no more than approximately 50% of the VuMark’s width from the border.

3.3.1 Design Tip – Using ‘Fake’ Elements
Sometimes it can be challenging to design your VuMark such that it has the exact
number of required Elements, but there is a technique to make this easier to
accomplish.
This technique involves creating more than the required number of Elements, and
designating some of them as “fake” elements. They are “fake” in that they look like real
elements but are actually not included in the Bright or Dark Elements layers – instead
they are placed in the Background layer. Since anything in the Background layer is
ignored by the Vuforia algorithm, your VuMark design technically has the exact number
of required elements that the algorithm expects.
For example: Your VuMark requires 122 Elements, but from a design perspective it is
hard to arrange your Elements in an aesthetically pleasing way such that you have
exactly 122 elements, but 128 elements fit nicely into your design. You would select
any 6 elements that you want to be considered “fake” and move them to the
Background layer.
In the example below, this particular VuMark only required 122 Elements in its design,
but the element layout worked best with 128 Elements. You can see that 6 of the
Elements have been set to look like “Dark” Elements but have actually been placed in
the VuMark-Background layer where they will not technically be treated as real
Elements.
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Figure 3 – Adding ‘fake’-Elements to the design

3.4 Background / Design Area
Since the Background / Design Area is not used for detection, there aren’t many
requirements or limitations for what you place there. You have a lot of freedom to
create a VuMark that expresses your brand or identity. Background can be empty; it’s
assumed to be white. Note that the background can influence the size of your VuMark
which affects minimal size of Elements, and Border & Clear Space width requirements.
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4 INSTALLATION OF VUMARK SCRIPTS IN ILLUSTRATOR
The recommended tool for designing VuMarks is Adobe Illustrator. There are three
custom scripts for use with Illustrator that will help you create, verify and export your
VuMark design.

4.1 Setup script
This script creates a new Illustrator file for your VuMark, which we refer to as the
VuMark template. It automatically creates the layers that you will place various parts of
your VuMark design into.

4.2 Verify script
This script helps you test your VuMark design by providing a list of design
requirements, Pass/Fail results for each requirement and suggestions for resolving any
issues that may have been found. You will typically run this script multiple times during
the design process as you make changes to correct failed conditions.

4.3 Export script
Once your design has been run through the Verify script and is determined to be
“ready for export”, this script will export your VuMark template as a Scalable Vector
Graphics (SVG) file. You will upload this SVG file into the Vuforia Developer Portal
Target Manager to create the dataset that will be used within your iOS, Android, Unity,
or Windows 10 application.

4.4 Installing and using the Illustrator Scripts
Download the VuMark Illustrator scripts from the Vuforia Developer Portal.
4.4.1 Mac
Open the /Applications/Adobe Illustrator CC 2015 folder/Presets/en_US/Scripts folder and
copy the VuMark folder containing all the scripts into it.
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4.4.2 Windows
Open the C:\Program Files\Adobe\Adobe Illustrator CC\Presets\en_US\Scripts folder and
VuMark folder containing all the scripts into it.
If you have Illustrator open, you must quit the application and re-open it to use the
newly installed scripts.
You can now run the scripts from the Illustrator menu: File > Scripts > VuMark
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5 CREATING A VUMARK IN ILLUSTRATOR
5.1 Using the Setup script
When you run the Setup script a dialog will appear that asks you to enter in a Name,
Type and ID Length for your VuMark. The Type and ID Length fields are used to
choose what type of data that you want to encode in your VuMark and this determines
how many Elements that your VuMark template must have. Given these inputs, the
script will configure your template accordingly.

Figure 4 – VuMark Template Setup
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Type

ID Length

String

Use this if an ID will consist of
printable ASCII characters.

If you choose String type, ID Length is the
number of characters that your value will have.

Numeric

Use this if an ID will only use numeric
digits 0 - 9.

If you choose Numeric type, you have to enter
the maximum numeric value that your VuMark
will encode. For example, if you want a
VuMark that supports numeric values from 0 to
20,000 you would enter ‘20,000’ in the
Maximum ID field.

Byte

Use this for data in a byte format.

If you choose Byte type, the ID Length is the
number of bytes that your value will have.

5.2 Template Layers
After running the Setup script you will have a new Illustrator file containing the layers
meant to hold the various parts of a VuMark, as well as several additional layers that
are also used in the design process. During the design process you may change order
of the layers, but make sure other layers don’t hide Border and ClearSpace graphics.
Also ensure Bright and Dark Elements are always visible in your design and not
covered by other graphics.
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Figure 5 - VuMark Layer Setup

IMPORT

It is not required that you use this layer, but we have found it helpful to
have a “work space” where you can paste your VuMark design. From this
layer, you can begin separating the various parts of your VuMark design by
moving them to the corresponding layers.

VuMark-Description

INFORMATIONAL, LOCKED – DO NOT ATTEMPT TO MODIFY THIS LAYER

VuMark-Feedback

This layer is empty at first, but after you run the Verify script, it will be
populated with feedback presented on top of your VuMark design to help
you verify that it meets the design requirements.

VuMarkAsymmetryMarker

CAN BE EMPTY

VuMark-Contour

This layer shall only contain one closed path with 4-20 straight edges.
Once you have placed your Border and Clear Space parts into their
corresponding layers, you must use the Pen tool in Illustrator to draw a

This layer contains the details of your VuMark such as the Name, Type,
Length and number of required Elements.
The Exporter script uses the information contained in this layer and that is
why it is locked by default to prevent accidental deletion.

When creating a rotational symmetric Contour, this layer can be used to
add Assymetry Markers that prevent from accidental wrong ID readout.
See section TODO on more details.
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closed path along the invisible “line” that is formed where these two parts
touch. This path must be placed in the VuMark-Contour layer.
VuMark-Origin

This layer contains a circle shaped object that represents a point that will
be considered the “origin” on your VuMark design. Augmentations that will
appear registered to the VuMark relative to this point. Move them in your
design to match required origin. Circle can be scaled.

VuMark-Border

This layer should only contain the object representing your VuMark’s
Border.

VuMark-ClearSpace

This layer should only contain the object representing your VuMark’s Clear
Space.

VuMarkBrightElements

This layer will contain the Elements in their Bright state. The number of
objects placed in this layer must match the number of required Elements
exactly. Make sure Elements are actually brighter than Dark state.

VuMark-DarkElements

This layer will contain the Elements in their Dark state. The number of
objects placed in this layer must match the number of required Elements
exactly. Make sure Elements are actually darker than Bright state.

VuMark-Background

CAN BE EMPTY

Contains background design. Use rich background if you intend to track
VuMark in Vuforia.
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VuMark-UserData

CAN BE EMPTY

This layer can contain graphical elements for various purposes, e.g. UI
overlays, printing marks, metadata, etc. The graphic placed in this layer
will be exported as part of the VuMark template SVG file and provided with
VuMarkTemplate::getUserData() method inside the SDK when the
VuMark is loaded.
The VuMark native public sample shows an example
of a detection highlight graphic displayed over the
VuMark. The blue line is a path we added to the
VuMark-UserData layer. Using this method you can
build UI that is agnostic to the actual VuMark-shape.

5.3 Separating the parts of your VuMark
A common design workflow starts a conceptual phase where you experiment with
various VuMark design concepts. Once you have chosen a design to move forward
with, you can copy and paste it into the IMPORT layer of your newly created template.
We have found it useful to place the design concept in the IMPORT layer and then start
moving each part of the VuMark design into their corresponding layers in the Illustrator
template.
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5.4 Drawing the Contour
As described earlier, the Contour is normally not explicitly defined in your VuMark’s
design up to this point!
Now that you have placed the Border and Clear Space parts into their corresponding
layers, you must use the Pen tool in Illustrator to draw a path along the length of the
invisible “line” that is formed where these two parts touch. Make sure that this path is
placed in the VuMark-Contour layer!

Figure 6 – Drawing the Contour path

NOTES:
• The Contour path will not be visible in real instances of your VuMark.
•

The Clear Space in above example has been filled in pink to help show its boundaries – it is
normally filled in white in this design.

It is helpful to give the path a 1-2 point stroke in a highly visible highlight color like
Magenta or Cyan so that you can easily see where the Contour has been defined.

5.5 Using the Verify script
After you have assembled the parts of your VuMark into their respective layers, you are
ready to test your VuMark design.
The Verify script will first check that your VuMark conforms to the design requirements
and then provides feedback in the form of a Pass, Fail, or Verify status message in an
artboard adjacent to your main artboard in Illustrator.

© 2016 PTC Inc. All rights reserved. The information contained herein is Confidential and Proprietary to PTC Inc.
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Feedback Artboard in Illustrator
After running the Setup script, you will have two
artboards: your main design artboard, and a
Feedback artboard adjacent to it.
The Feedback artboard provides a quick
summary of the VuMark properties you have
chosen, as well as a checklist of what will be
verified by the script.
Before you have run the Verify script, the Design
Guideline Verification section of the Feedback
artboard will show a “FAIL” status for each item.
It is useful to refer back to these status
messages since they provide a reminder of the
key design requirements your VuMark must
adhere to.
Once you run the Verify script, the Feedback
artboard will update to display the latest
verification results.
What the script verifies
• Number of Elements
• Element sizes and locations
• Element contrast
• Contour segments
• Border and Clear Space contrast
• Border and Clear Space width
(visual verification by user is required)
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5.6 Understanding the Feedback layer overlays
5.6.1 Element sizes
The Verify script provide a Pass/Fail result for Element sizes. It draws on the
VuMark-Feedback layer magenta circles on top of every Element it finds. You should
inspect the Elements in your design to make sure that they occupy or fill at least the
same size and area as the circles. This visualization also helps to identify which
Element cases the script to fail.

FAIL
• Some of the magenta circles touch or overlap
with each other.
• The size of some of the Elements are smaller
than the size of the magenta circles. Notice
how some of the yellow “windows” in the
design do not completely fill the area indicated
by circles.
• Some of the magenta circles overlap the
Border area.

PASS
• All Elements are at least the same or larger
size/area as the magenta circles.
• None of the magenta circles touch each other.
• The magenta circles don’t overlap the Border
area.

5.6.2 Border & Clear Space width
The Verify script doesn’t automatically provide a Pass/Fail result for the Border and
Clear Space widths but the feedback layer will display overlays that indicate the
required Border and Clear Space sizes on each side of the Contour. In the examples
below you can see how a magenta fill is overlaid on each side of the Contour to
indicate the minimum width required for the Border and Clear Space.
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FAIL
• Border width is too small. Notice how the
minimum Border width extends past the actual
Border.
• Clear Space width is too small. Notice how the
minimum Clear Space width extends past the
actual Clear Space.

PASS
• Border is at least the same width as the minimum
Border width indicated by the magenta overlay.
• Clear Space is at least the same width as the
minimum Clear Space width indicated by the
magenta overlay.

Both the Border and Clear Space must be filled paths or compound paths.
ILLUSTRATOR TIP: If you’ve designed your Border or Clear Space with a path that
has a simple stroke width, you can use Illustrator’s “Object->Expand…” or “Object>Expand Appearance” to convert it to a compound path.
Any “Appearance Attributes” that are assigned to your shapes, paths, or objects in
your VuMark must be removed prior to exporting as an SVG.
ILLUSTRATOR TIP: You can use the Appearance Panel’s menu option “Reduce to
Basic Appearance” to remove the Appearance Attributes.
The VuMark-Border and VuMark-ClearSpace layers should only contain a single path
or compound path each. The VuMark-Contour should contain only a single path that
has exactly as many anchor-points as corners there are in your Contour. Make sure
there is no overlapping anchors in your path. Use the “Document Info->Object” panel
to list the anchor points by selecting the Contour path only.
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5.7 Using the Export script
5.7.1 Export Script
When your VuMark design receives a “Pass” status for each of the items in the Design
Guidelines Verification section and the message “VuMark Template ready for export”
appears on the Feedback artboard, you can now run the Export script.
The Export script will again run verification, create a new file in Illustrator, and move
contents from your VuMark template file gradually over. It will automatically trim your
design artboard so that it is exactly the size of your VuMark design. It will then prompt
you to save your VuMark template as an SVG file.
5.7.2 Common problems
Occasionally you may find that the artboard trimming doesn’t work correctly, and your
artboard still appears larger than your VuMark design. Typically, the reason this
happens is that there are one or more objects on your artboard that may be invisible to
you, but are still there and the script interprets these as being part of your VuMark
design. To fix this, you should inspect each of your layers looking for any objects that
aren’t part of your intended design and remove them. Sometimes there are invisible
elements in Compound Paths or Sub-Layers preventing correct clipping. After cleanup
you can run the Export script again and check that the artboard is trimmed correctly.
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5.8 Target Generation in the Vuforia Developer Portal
In the Vuforia Developer Portal create a VuMark database. Since VuMark databases
need to be associated to licenses, they cannot contain other target types. If you need
to use different target types in your application download them as separate Device
Databases and load them as simultaneous datasets.
Upload the VuMark SVG Template to create a VuMark target dataset on “Add Target”.
The Device Database download process of the VuMark target is identical to other
targets.
Additionally, you have the possibility to directly generate instances of the VuMark in the
Vuforia Developer portal UI.

Figure 7 - VuMark Template Upload

6 ADVANCED TOPICS
6.1 Rotational Symmetry – Asymmetry Markers
We recommend to create designs that are not rotational symmetric, compare below:
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Non-rotational symmetric

Rotational symmetric
[orders: 6, 5, 5, 5]

Figure 8 – Rotational symmetry examples

When contours are used that are rotational symmetric, there is a minimal, theoretical
chance that a Code contained in a certain specific instance may not be read out
correctly. If you want to assure that this never happens you will need to add
Asymmetry Markers to your design.
Asymmetry Markers are little circles manually added to the “VuMarkAsymmetryMarkers” layer, named in order “a0000”, “a0001”, “a0002”, … . Their
purpose is to markup one arbitrary, rotational symmetric location in your design with
respect to the Contour rotation, that fulfills following criteria (see Figure 10 and Figure
11 for examples):
• The number of Asymmetry Markers must be identical to the symmetry order of
your Contour (see Figure 8 for examples).
• When rotated around the symmetry center, individual Asymmetry Markers need
to fall onto each-other. Basically they need to be on rotational symmetric
locations (as shown in Figure 9).
• One, and only one out of the multiple Asymmetry Markers must have in its
center a different color than the other markers. The reason for that is that this
specific marker is used to ‘lock’ the orientation to a specific rotation. The
contrast between the one and the other markers should be similar to what is
used for Dark/Bright elements.

Figure 9 - Asymmetry Marker Placement Example
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Figure 10 – Order 2 asymmetry marked up in “ACME” design

Figure 11 - Order 4 asymmetry marked up in “EAP” design
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7 OTHER CONSIDERATIONS
7.1 Physical Size
VuMark instances are generated in PNG, PDF, or SVG formats by Vuforia. Printing PDF
documents will create the VuMark printouts in exactly the same size as you have
designed them in Illustrator. When creating printout based on PNG or SVG files you
should manage the print size correctly.

7.2 Detection Range
The detection range of a VuMark is limited by its apparent size in the mobile
applications live camera viewfinder. The VuMark shall cover around 1/4-1/16th of the
live camera view in your application. This means, in a typical use scenario the user of
your app shall be able to hold the mobile device camera pointing to a VuMark, so that
the VuMark appears to cover 1/4-1/16th of the screen.
The recommended smallest physical size of a VuMark shall be not smaller than a dime
(~1 inch or 25mm). In case of a small VuMark when you move the device closer to the
VuMark to fulfil above coverage requirement, at some point the camera will fail to
focus.

7.3 Printing
VuMarks should be printed on paper and other media that ideally has a matte surface.
Avoid glossy and reflective surfaces. The VuMark must be flat to be detected and
tracked accurately.

© 2016 PTC Inc. All rights reserved. The information contained herein is Confidential and Proprietary to PTC Inc.

28

8 TIPS & TROUBLESHOOTING
8.1 Troubleshooting VuMark creation/detection fails
Due to the variety of ways how a VuMark design can be created there may be still
cases when verification and export of the VuMark succeeds, but the VuMark
generation upon upload to the Developer Portal fails, or even that a downloaded
VuMark dataset is not capable of detecting instances (e.g. the “0” instance displayed in
the VuMark Target detail panel.
Try to apply one of the recommended fixes based on the below listed possible
reasons. We will work on improving the Illustrator toolchain over time to catch these
issues and either provide feedback or automatically fix/bypass below mentioned
cases:
•

Overlapping points in Contour path causing more points than actual
corners in contour. When the Contour is not created carefully using the PenTool as recommended, more points end up in contour path than your visual
design actually has. Please verify using Document Info>Objects that you have
as many points in the closed path as your design actually has when counting
corners of contour visually.

•

Check maximum angle limit between contour segments is 150°.

•

Shape transformation in Contour/Border/Clear Space elements.
Move/rotation/scale of an object results in an update to the anchor points of a
path/compound path. Shapes however can store above changes either as
update to their width/height and position coordinates OR in a separate
transformation. If you find in your failed VuMark SVG Template file
transform="matrix( … attributes, use the Object>Shape>Expand Shape
command to flatten them as paths.

•

Don’t use appearance attributes for Elements/Contour/ClearSpace/Border!
When listed objects have appearance attributes their export to SVG is not
always properly rendered and verification may provide incorrect results. You can
easily identify the issue, as appearance attributes are displayed with a filled dot
in Layers panel:
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Figure 12 - Appearance attribute is used in VuMark-Border layer

To fix this issue select the object and use Object>Expand Appearance.

8.2 Calling Scripts with Keyboard-Shortcuts on MacOS
To save time during iterative checks using the VuMark Verify script, you might want to
setup a keyboard shortcut to run the script. Shortcuts are OS platform-specific and
techniques will vary. As a convenience, instructions for one way to do so on the Mac
version of Illustrator are provided below:
1.
2.
3.
4.

Launch Mac Automator
Select “Service” and click the “Choose” button to accept
Set the following values: Service receives “no input” in “Adobe Illustrator”
Add a “Get Specified Finder Items” and click “Add” to select Vumark-Verify.jsx
script located in the “Presets/en_US/Scripts/” folder of Illustrator app
5. Add an “Open Finder Items” and set it to the Illustrator app
6. Save your new workflow service with name such as “VuMark-Verify”

7. Open Keyboard in Settings and select Shortcuts tab
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8. With “Services” selected, scroll till you find “VuMark-Verify” and then click “add
shortcut” and choose an available key combination.
9. Restart Illustrator and check Services for your script with assigned hotkey.
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